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2016 Knowledge-Based Audits™ of Dealerships for ProSystem fx® Knowledge Coach
Welcome to 2016 Knowledge-Based AuditsTM of Dealerships for ProSystem fx® Knowledge Coach
This Release Notes document provides important information about the 2016 release of Knowledge Based Audits TM of Dealerships.
Please review this information carefully. If you have any questions, contact Customer Support at 1-800-PFX-9998, option 4, then
option 1. Additional information is available on CCH Support Online.

New in this Release
Knowledge-Based Audits of Dealerships is designed to help the auditor efficiently and effectively perform financial statement audits of
dealership entities in accordance with auditing standards generally accepted in the United States of America (U.S. GAAS) promulgated
for nonpublic entities by the AICPA’s Auditing Standards Board. This publication is applicable for all types of dealership entities,
including vehicle and equipment dealers.
The operations of dealerships are generally unique and complex and require specialized accounting and auditing knowledge. Dealerships
face some unique accounting and reporting challenges (e.g., inventory; financing income; insurance income; commissions; warranties,
and repossession losses) that auditors should be aware of when planning and performing the audit engagement.
This specialized dealership approach contains documents and audit programs that have been developed to help the auditor apply an
audit approach. Entities may have other material transactions that will require additional procedures not anticipated by the KBA
methodology. The auditor needs to design appropriate procedures and incorporate them into the engagement plan.
Conducting audits of dealerships requires the exercise of the auditor’s professional judgment.
The 2016 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20Dealership%20Title%20Overview%20for%20Knowledge
%20Coach%20Users.pdf
The 2016 Knowledge-Based Audits of Dealerships is current through:

 FASB Accounting Standards Codification as of March 31, 2016, and through Accounting Standards Update (ASU) No. 2016-09,
Compensation - Stock Compensation (Topic 718): Improvements to Employee Share-Based Payment Accounting.
The tools in Knowledge-Based Audits of Dealerships have been updated to incorporate the 2013 Internal Control-Integrated Framework
(Framework) established by the Committee of Sponsoring Organizations of the Treadway Commission, independence considerations,
and in accordance with changes in the AICPA Code of Professional Conduct, including the Compliance with Standards Rule (ET Section
1.310.001). Additionally, the tools are current through AICPA Statement on Auditing Standards (SAS) No.129, Letters for Underwriters
and Certain Other Requesting Parties.
Knowledge-Based Audit (KBA) Methodology - Allows the results of one set of procedures to become the input for the next. The key
components of the KBA methodology include:

 An Overview that guides auditors through the methodology;
 Knowledge-Based Audit documents, integral to the risk assessment and overall audit processes, which contain steps and
procedures required by GAAS;

 Customizable Audit Programs that take auditors through related steps and procedures;
 Practice Aids to help auditors complete steps or processes outlined in the Knowledge-Based Audit documents and Audit
Programs;

 Auditor’s Reports that provide a variety of sample auditor’s opinions on audited financial statements; and

 Correspondence documents that provide sample letters to be used to comply with GAAS requirements and in many other
common situations.

 The AICPA’s Auditing Standards Board’s (ASB) Risk Assessment Standards - The practice aids and tools in the 2016 KnowledgeBased Audits of Dealerships are designed around the AICPA’s risk assessment and clarified standards to assist auditors of
dealerships by:


Facilitating compliance with GAAS and GAGAS;



Encouraging more effective audits through tailored audit programs and comprehensive practice aids;



Helping auditors to focus on and respond to identified audit risks; and



Enhancing audit documentation.

ProSystem fx® Knowledge Coach

 ProSystem fx® Knowledge Coach functionality allows auditors to use the Knowledge-Based-Audit methodology more efficiently
by eliminating the need for duplicate entry of the same information, tailoring audit documentation to each particular
engagement, and documenting the link between risks identified and procedures performed. AUD-100 Tailoring Question
Workpaper is a document in Knowledge Coach that presents engagement-level questions designed to aid in tailoring the
engagement documentation to fit each client. Completing the questions helps the auditor avoid duplication and unnecessary
workpapers.

 Before you begin your audit, please review the guidance in AUD-101 Overall Audit Program. This workpaper is intended to be
your road map through a Knowledge-Based Audit methodology. You should start your audit with AUD-100 Tailoring Question
Workpaper and AUD-101 Overall Audit Program.

 Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-502
Summary of Risk Assessments. This allows the user to continuously assess risks during the engagement. Several workpapers
prompt the consideration of the presence of risks, but the Risk Summary task pane must be used to document those risks. All
documented risks flow to the Risk Summary. To ensure risks show in findings tables, make sure to check the “workpaper
identified in” field of the Risk pane.

 Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the audit file.

 Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks
or relevant assertions, missing workpaper, and more.

 Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes audit content, you can link
directly to source material from Resources within Knowledge Coach workpapers. These links have been updated to reference to
the accounting standards under the FASB Accounting Standards Codifications and the auditing standards issued by the AICPA.

 Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane.
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more
effectively and efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH’s Accounting
Research Manager and industry audit guides by simply clicking on the Reference.
Important Notes

 Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.
 If your Current Editor Knowledge Coach Microsoft Office® Word workpapers become read-only or crash, please do the
following:
o
o

Keep the binder with the affected workpapers open.
Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.

 Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach
workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central file
room and through peer-to-peer sync in the same way other Engagement workpapers are shared.
System Requirements
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 This title MUST be used with ProSystem fx ® Engagement version 7.2 or higher, ProSystem fx® Knowledge Coach version 2.2,
and 2015 Financial Statement Base v7 and higher. If you have not installed the ProSystem fx® Engagement 7.2 and Knowledge
2.2 Update May 2016, ensure that you do so before using this title. If you are upgrading from ProSystem fx® Engagement 7.1 or
lower please contact Technical Support at 1-800-PFX-9998, option 4 for detailed instructions.

 A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx®
Knowledge Coach workpapers.

Download Instructions
You must run the License Update Utility BEFORE adding the 2016 Knowledge-Based Audits of Dealerships to Engagement version 7.2 by
performing the following steps:
1. Download the License Update Utility and Engagement version 7.2 License Update File from the following site
2. Right click on PfxEngUpdateUtility and Run as administrator
3. Log in to the utility using your Admin log in
4. Browse to LicenseUpdate7.2_20160418.upd that was downloaded along with the utility
5. Click “OK” to run the update
6. You will receive a message when the update isa complete
7. Open the ProSystem fx Engagement Admin application and assign licenses to your staff
Download the 2016 Knowledge Based Audits of Dealerships from the ProSystem fx ®Knowledge Coach Updates section of the
ProSystem fx® Engagement Support Web site at the following URL: http://support.cch.com/updates/KnowledgeCoach, then select the
Knowledge Coach Series and Download file link next to the 2016 Knowledge-Based Audits of Dealerships. On some occasions the
content package file (.KCP) will download with the extension changed to .ZIP. If this occurs, please change the extension of the
downloaded file to KCP using all capital letters.
You must install the 2015 Financial Statement Base v7 title before installing the 2016 Knowledge Based Audits of Dealerships.
The Financial Statement Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach
If you have already installed this title for 2016 Knowledge-Based Audits of Dealerships, ensure you have the latest Knowledge Coach
Content Update installed.
Important: ProSystem fx® Engagement version 7.2 or higher and Knowledge Coach version 2.2 must be installed on the computer in
order to install this Knowledge Coach title. Additional requirements include Microsoft® Office 2007, Microsoft® Office 2007 Primary
Interop Assemblies (PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System
Runtime version 3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office
Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS).
The 2016 Knowledge-Based Audits of Dealerships (5/26/2016). KCP download is a proprietary file that must be installed from within
Engagement. Save this KCP file to a location on your local drive and follow the Installation Instructions included in the Release Bulletin.

Installation Instructions
Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files.
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.
After downloading the 2016 Knowledge Based Audits of Dealerships, do the following:

 Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select
Tools > Knowledge Coach Titles.

 The Knowledge Coach Titles window will be displayed.
 Choose Add Title.
 Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support
Web site.

 Choose Open.
 The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.
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Once the title is added, you must release it, so that other staff members in your firm can use it. You may also wish to “unrelease”
previous versions of the title.
To unrelease a title:

 Select a version of the KBA Dealership titles.
 Choose Unrelease Title. The date will be removed from the Date released column and staff that do not have the staff group
property right to insert unreleased titles will not be able to insert the unreleased titles into a binder.
Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File >
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.
To release a title:

 Select one of the Knowledge Coach titles in the list that has been added but is not yet released.
 Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”
Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the ProSystem fx ®
Engagement Administrator before using the workpapers.
Important: Once the 2016 Knowledge-Based Audits of Dealership titles have been added and released, they will be automatically
deployed to other staff members when they login to the “Office” location, or when they synchronize a binder that contains Knowledge
Coach workpapers from this title.

Online Permission Key
Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.2 and higher. After
updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2016
Knowledge-Based Audits of Dealerships.
If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.
Permission keys are no longer generally distributed via floppy diskette. You can choose to continue receiving the diskette by going to
https://prosystemfxsupport.tax.cchgroup.com/service/accountadmin/ , clicking the Firm Administration link, and making the
appropriate selection (SSO access is required), or by contacting Customer Service at 1-800-PFX-9998, option 4.

Accounting Research Manager
CCH’s Accounting Research Manager is the most comprehensive, up-to-date and objective online database of financial reporting
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.
Our Weekly Summary email newsletter highlights the key developments of the week, giving you assurance that you have the most
current information. It provides links to new FASB, AICPA, SEC, EITF, and IASB authoritative and proposal-stage literature, plus guidance
from financial reporting experts.
Our team of content experts updates the system on a daily basis, so you can stay as current as possible. What’s more, our experts
attend critical, standard-setting meetings and summarize the results for you, which means you’ll learn of newly released literature and
deliberations of current financial reporting projects as soon as they occur! Plus, you’ll benefit from their easy-to-understand technical
translations. Our expert’s interpretations clearly lay out what the rules mean from your perspective.
Also available in the Knowledge-Based Audits of Dealerships title, a guide that helps you comply with the most recent professional
standards and guidance for the conduct of compilations and reviews and to integrate the use of practice aids, tools, and other resources
with its guidance. This publication supplements and complements the Knowledge-Based documents that are available in Knowledge
Coach.
With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the
Shortcuts bar in the Binder window.
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Reference to Accounting Research Manager (ARM) – If you subscribe to an ARM library that includes dealerships content, you can link
directly to source material from Resources within Knowledge Coach documents. These links have been updated to refer to the
accounting standards under the FASB Accounting Standards Codifications.

Using Your Knowledge Coach Content
To use your Knowledge Coach Workpaper Templates, open a binder in
ProSystem fx® Engagement, select the workpaper tab into which you would
like to insert the workpaper, and select New Knowledge Coach Workpaper
from the toolbar or File menu. The New Knowledge Coach Workpaper dialog
appears (Figure 1).
Select the New Knowledge Coach Title with the content you would like to
use. You can only select titles you have installed. The information displayed
changes to reflect the workpaper organization available for the selected title.
Select the Knowledge Coach Workpaper Templates to insert into your binder
and click OK. The Selected Workpaper Properties dialog appears. Each
workpaper name is automatically loaded into the Name field. Add a
workpaper index in the Index field and make any Name modifications you
desire. You can also modify the tab location or the roll forward settings for
each workpaper. Then click OK. The integrated Knowledge Coach workpaper is
now inserted into your engagement binder. For more information on how to
use Knowledge Coach workpapers in your binder, see the Knowledge Coach
User Guide.
Figure 1 - New Knowledge Coach Workpaper
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Download
Description:

2016 Knowledge-Based Audits of Dealerships
Title(5/26/2016)

Version:

Engagement v. 7.2 with Knowledge Coach 2.2 or higher and
2015 Financial Statement Base v7

Release Date:

May 2016

File size:

18MB

Approx. Download
42 minutes at 56 kbps
Time:
License:

Full Version

Platforms:

Windows® 7, 8 and 8.1

Office:

Microsoft® Office 2010 or higher required

Contact Information

 For a demo or to purchase additional titles as they become available 1-800-PFX-9998, option 1
 Technical Support

1-800-PFX-9998, option 4, then option 1

The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a
Wolters Kluwer business. The contact information above can be used for customer service and support issues for this product. For
information about other CCH products, please call 1-800-248-3248 or visit the online Store at http://tax.cchgroup.com.
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